
 
 
 
 
 

      
 

Newsflash 
Printing Services at the 9th & Colorado campus 
accepts print jobs from all UCDHSC locations.   

We’re fast, efficient, and friendly.   
To see how we can help you, contact us at:  

303-315-7121 
http://www.uchsc.edu/printing
DEPARTMENT DIRECTORY 
 
Vice Chancellor for  
Administration and Finance 
Teresa Berryman 
303-315-2750 
 
http://www.cudenver.edu/Administration/
 
http://www.uchsc.edu/admin/
 
 
Click titles to visit Department Websites 
 
Budget and Operations
Louise Vale, AVC 
303-315-2769 
 
Facilities Operations
Dave Turnquist, AVC 
303-724-1100 
 
Finance
Jeff Parker, AVC-Controller 
303-724-0053 
 
Human Resources
Betsy Rodriguez, AVC 
303-315-2717 
 
Information Systems
Bill Freud, AVC 
303-724-0493 
 
Institutional Research
Denise Sokol, AVC 
303-315-2835 
 
Student Financial Services
Bill Herbstreit, Interim AVC 
303-556-6153 
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UCDHSC Abbreviated Telephone Dialing 
Rob Lee 
UCDHSC Telecommunications and Auraria Higher 
Education Center (AHEC) have implemented 
abbreviated dialing across the Downtown Denver 
and HSC Campuses.  Using abbreviated telephone 
dialing codes will save you time when placing calls 
between the AHEC telephone system and the HSC 
telephone system. 
 
To reach any AHEC telephone from any UCDHSC 
telephone, dial * plus the 5-digit extension. 

Example:  A person trying to reach the Downtown 
Denver Campus (DDC) Scholarship/ Resource 
office (303-352-3608) from a UCDHSC telephone 
would dial *2-3608. 
 
To reach any UCDHSC telephone from any AHEC 
telephone, dial *4 plus the 5-digit extension.  

Example:  A person trying to reach the University 
of Colorado Hospital operator (303-372-0000) 
from an AHEC telephone would dial *42-0000. 
 

 
 

Fiscal Year 2005-2006 ITS Auxiliary Rates  
Adrienne Powers 
One of the most notable changes this year is that we 
have a new name.  We have changed our 
department name from “IS” at the UCDHSC 
campuses and “CINS” at the Downtown Denver 
campus (DDC) to Information Technology Services 
(ITS).  We welcome you to our consolidated 
department and are committed to provide you with 
the same high quality service as we have done in the 
past. 
 
While services have essentially remained the same 
on each campus, we are happy to announce that 
there will be a reduction in the cost of telephone 
service.  We will be reducing the phone rate to 
$22.50 per phone per month.  Later this summer we 
will be changing our long distance carrier and long 
distance calling cards from MCI to Qwest, which 
will result in a rate reduction for long distance 
service.  Rates for our other campus technology 
services remain unchanged. 

   Shortcut        Location        Phone Prefix 
*42-xxxx UCH 9th Ave  372 
*6-xxxx  DDC AHEC  556 
*2-xxxx  DDC AHEC  352 

 
The Market Basket 
The table below shows the monthly cost of typical 
services that a person on at the 9th Avenue or 
Fitzsimons Campuses purchases from Information 
Technology Services.  This is what we call the 
information technology market basket.   In FY06, a 
typical market basket of services will cost $1.45 
less per month than it did in FY05.  

Shortcut Location          Phone Prefix 
*42-xxxx UCH 9th Ave  372  
*43-xxxx  UPI/Fitzsimons 493 
*44-xxxx  UCDHSC/Fitzsimons 724 
*45-xxxx  UCDHSC/9th & DDC  315 
*48-xxxx UCH Fitzsimons  729-848  

 

Description 
FY06 
Rate 

FY05 
Rate Diff. 

Voice Connection $22.50 $23.58 ($1.08) 
State to State/hour $  3.07  $ 3.44 ($0.37)
Basic Numeric Pager  $  5.89  $  5.89 $ 0.00
  Subtotal $31.46  $32.91 ($1.45)
Central File Servers $11.66  $11.66 $ 0.00 
  Total $43.12  $44.57 ($1.45)

Quote of the Day 
 

If the world seems cold to you, 
kindle fires to warm it.  

 

Lucy Larcom,  Poet 
(1826-1893)

 
For more information regarding UCDHSC ITS 
Auxiliary services and rates, please click on 
http://www.uchsc.edu/its/finance/  or contact the 
ITS Finance Department at (303)724-0472. 
 

http://www.uchsc.edu/its/finance/
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Human Resources Update 
Florie Montoya 
UCDHSC Human Resources was consolidated last 
August and staff are now located at the Downtown 
Denver campus. The Employee Relations and 
Training unit including Sam John, Manager, 
Richard Benson, and Greg Rowe have moved from 
Fitzsimons to the downtown office. The Downtown 
Denver HR staff (Doug Kasyon, Florie Montoya, 
and Brooke Fitzpatrick) have moved to the 10th 
floor of the Lawrence Street Building and are now 
part of the Employee Relations and Training team.     
 
For the Human Resources organizational chart, go 
to:http://www.uchsc.edu/hr/HR_Org_Chart.doc.  
New phone numbers for all staff are also listed on 
the website at http://www.uchsc.edu/hr/mstrdir.htm 
and, for a limited time, are available by voice mail 
by calling the old numbers.  There is no change to 
e-mail or website addresses at this time.   
 
The HR websites will be consolidated this summer.  
While the consolidation is under way, we will 
maintain two websites: 
 

Health Sciences Center 
http://www.uchsc.edu/hr/

 
Denver 

 http://www.cudenver.edu/resources/human+resources/
 

All Job Announcements 
http://www.uchsc.edu/hr/employ1.htm

 
 
We are also in the process of reviewing policies, 
processes, forms and staff assignments. 
 
We will maintain a Human Resources satellite 
office at Fitzsimons staffed by Marybeth Hutchins 
where employees can pick up paychecks, view job 
postings, and complete I-9 forms. Payroll and 
Benefit Services staff is available on Monday, 
Wednesday, and Friday and Bernadette Mirelez, 
International Tax Advisor, is available on 
Wednesday and Thursday. Currently the office is 
located in Building 500, 4th floor. The phone 
number is 303-724-0144 and fax number is 303-
724-0811. 

 
The Payroll and Benefit Services office at the 
Downtown Denver campus is still on the 14th floor 
of the Lawrence Street Center at this time. A 
representative is available on Tuesday and Thursday 
of each week.  The International Tax Advisor is 
available on Monday and Friday of each week.  The 
phone number is 303-556-6297. 
 
If you have questions or concerns regarding our 
move, please contact Betsy.Rodriguez@uchsc.edu, 
Assistant Vice Chancellor, Human Resources at 
303-315-2707 or Kevin.Jacobs@uchsc.edu, HR 
Director at 303-315-2727. 

 
 
 
AIR Annual Forum 
Denise Sokol 
Lucy Dwight, Senior Research Coordinator, 
attended the 2005 Annual Forum of the Association 
for Institutional Research (AIR) in San Diego, May 
28-June 1.  She delivered a research presentation, 
“Faculty Salary Equity – Does Merit Matter?,” 
describing several statistical methods used to assess 
salary equity on the Downtown Denver campus. 
 
Ying Ling, Senior Research Coordinator, also 
attended the AIR Annual Forum, presenting a paper 
titled “Meeting the Challenge of Nursing Shortage.”  
This paper examines the demand and supply for 
registered nurses (RN) in the state of Colorado, and 
how UCDHSC has been a major producer of skilled 
RNs that serve the needs of the state. 
 

Make Note of Your Employee ID 
Number 
Florie Montoya 
As everyone becomes more privacy-sensitive we 
need to ensure that we use our employee 
identification numbers instead of our social 
security numbers. Your ID number is recorded 
on your pay stub or can be provided to you by 
Human Resources or your department HR 
contact. 

http://www.uchsc.edu/hr/HR_Org_Chart.doc
http://www.uchsc.edu/hr/mstrdir.htm
http://www.uchsc.edu/hr/
http://www.cudenver.edu/resources/human+resources/
http://www.uchsc.edu/hr/employ1.htm
mailto:Betsy.Rodriguez@uchsc.edu
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Mayo Clinic Pays $6.5 Million to Settle 
Allegations Regarding Questionable 
Accounting Practices 
JoAnn Pugh and Amy Gannon 
During May 2005, the Mayo Clinic paid $6.5 
million to settle allegations that it misspent millions 
of dollars in National Institutes of Health (NIH) 
federal research funds for over a decade.  Federal 
officials have accused the Mayo Clinic of 
improperly using $63 million in federal grant funds.  
Before the settlement, the Justice Department 
accused Mayo of routinely transferring money from 
one grant to another to pay for unauthorized 
expenses and hiding the transactions from the 
government agencies that paid the bills.  In addition, 
the Justice Department found the clinic’s records 
were not accurate, current, or complete and that the 
clinic had no effective controls in place and no real 
accountability for the funds.  Mayo officials deny 
the accusations and contend that all the expenses 
were proper even if no documentation existed to 
justify them. 
 
NIH has yet to decide whether or not it will classify 
the clinic as “high risk.” Although this designation 
would not prevent future NIH funding, this label 
would tarnish the reputation of the clinic and create 
administrative headaches for its researchers. 
 
Expenses should only be transferred or charged to a 
grant if the expenses are: 
• Allowable per the grant/contract; 
• Reasonable and necessary (directly benefit) the 

contract/grant;  and, 
• Charged in proportion to the benefit received.   
 
Expenses can never 
be transferred onto a 
grant to avoid cost 
overruns or due to a 
budget surplus.  
Documentation of the 
expenses (e.g., 
procurement card 
receipts, invoices) 
must be maintained to demonstrate validity of the 
expense and benefit to the contract/grant.   

 
With the consolidation, the campus is working on 
revising the campus policies for sponsored projects.  
The current policies for Health Sciences Center can 
be located at http://www.uchsc.edu/policies/ under 
Grants and Contracts.  For the Downtown Denver 
Campus, questions regarding sponsored project 
policies should be referred to the Division of 
Sponsored Programs Administration and Sponsored 
Programs Accounting at: 
 
 http://www.cudenver.edu/Academics/Sponsored+Programs/. 
 
If you have questions about policies or compliance 
issues, please contact the Financial Compliance 
Auditor, JoAnn Pugh at joann.pugh@cudenver.edu, 
phone (303) 556-6108. 

 
 
 
DDC Student Engagement Survey Results  
Denise Sokol 
Results of the 2004 National Survey of Student 
Engagement (NSSE) and Faculty Survey of Student 
Engagement (FSSE) for the Downtown Denver 
Campus are now available on the Office of 
Institutional Research, Planning and Analysis 
website.   
 
The NSSE is an annual survey of freshmen and 
seniors at 4-year institutions designed to assess the 
extent to which these institutions engage in a variety 
of good educational practices.  The FSSE is 
designed to provide information parallel to the 
NSSE from a faculty perspective.  To view our 
analysis go to: 
 
 http://www.cudenver.edu/Resources/Institutional+Research/. 
 
 

Source: Lerner, Maura. “Mayo May Get Tighter 
Scrutiny.”Star Tribune. June 4, 2005.  
 

http://www.startribune.com/stories/1556/5439136.html

The incident at Mayo 
is an important 
reminder of how 
critical it is that 
federal funds are 
expended as required 
by federal, sponsor 
and campus policies.  

http://www.uchsc.edu/policies/
http://www.cudenver.edu/Academics/Sponsored+Programs/
mailto:joann.pugh@cudenver.edu
http://www.cudenver.edu/Resources/Institutional+Research/
http://www.startribune.com/stories/1556/5439136.html
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Accepting Credit Cards Payments 
Kim Huber, Director of Accounting and Joe Tinucci, 
University of Colorado Treasurer’s Office 
In today’s society, as more and more transactions 
are being handling over the Internet, credit card 
fraud is becoming rampant.  Just recently there have 
been several news articles about internet break-ins 
to a credit card processor’s network whereby 
millions of credit card numbers were stolen.  Credit 
card numbers were also recently stolen at two major 
universities in California.   
 

IIff  tthheessee  mmaannddaattoorryy  
ddaattaa  ssttaannddaarrddss  aarree  
nnoott  ffoolllloowweedd,,  ffiinneess  ooff  
$$220000,,000000  oorr  mmoorree  ccaann  
bbee  lleevviieedd  aaggaaiinnsstt  CCUU..  

As a result of recent 
break-ins there is 
heightened awareness 
with respect to data 
privacy and security.  
MasterCard and Visa, 
under the auspices of 
the Payment Card Industry Data Security Standard 
(PCIDSS) requirements, are currently requesting all 
credit card merchants certify that safeguards are in 
place to prevent unauthorized access to credit card 
information.  Everyone  of us that uses a credit card 
in the payment of goods or services assumes that 
the merchant has implemented the necessary 
safeguards to protect our credit card number. 
 
What is the University doing about this? 
 
Within the past 60 days, the University of Colorado 
Treasurer’s Office has sent out a questionnaire to all 
campus departments which process credit card 
payments (if your department did not receive this 
survey and you accept credit cards as a method of 
payment, please contact Joe Tinucci in the 
Treasurer’s Office at 303-492-9326).  The purpose 
of the questionnaire was to determine the various 
methods campus departments use to process credit 
card payments (e.g. internet, swipe terminals, and 
manual processes).  Based on the initial 
questionnaire, a risk assessment is being assigned to 
each department.   
 
The Treasurer’s Office is currently in the process of 
hiring an outside consultant to analyze the 
University’s risk with respect to accepting credit 
card payments based on the initial 

 
assessment.  Individual meetings with the 
consultant will be held with those departments that  
are determined as high risk (e.g. accepting credit 
card payments over the Internet) and plans 
developed for bringing the department into 
compliance, if necessary. 
 
General campus meetings will also be held for those 
departments that use a swipe card terminal over the 
telephone line or a manual process where a 
telephone call is made to MasterCard / Visa for 
authorization (called ARU).  The general campus 
meetings will outline the minimum (paper) business 
practices and standards necessary to ensure the card 
holder information is being maintained in a secure 
environment.  For a general overview of the credit 
card merchant guide go to the Treasurer’s website at 
http://www.cu.edu/treasury/.   
 
What should a department do now if it is accepting 
credit cards payments? 
 
Via the Internet 
 Professional programming is necessary and many 
of the Visa / MasterCard requirements are of a 
technical nature (e.g. data encryption, firewalls, 
secure cookies) and require programming skills not 
normally possessed by departmental programmers 
or student staff.  If payments are being accepted 
over the internet, ensure that credit card data is not 
being stored on the University’s network and 
contact the Treasurer’s Office at 303-492-9326 to 
confirm that the vendor handling the payment 
information is on the Treasurer’s Office approved 
third party vendors list.  Using secure third party 
credit card services also meets many of the 
requirements of the PCIDSS.   
 
Via Swipe Card Terminals and Manual 
Processing  
Departments should ensure that hard copy reports 
containing credit card numbers are locked in a 
secure cabinet and destroyed after 30 days.  If 
departments want to keep a copy of the credit card  
transaction, the credit card number needs to be 
obliterated.  For most departments at the Downtown 
Denver Campus, credit card processing is still being 
 

Credit Card Processing continued on Page 6 
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Credit Card Processing 
 continued from Page 5 
handled by the Bursar’s Office.  However, please 
remember to not request credit card information via 
the internet (the University’s network may not be 
secure); it must be over the telephone or fax.  If 
faxed, a departmental representative needs to be at 
the fax machine when the information arrives in 
order to properly secure the credit card data. 
 
Note:  If the department is accepting payment card 
information via telephone, fax, or in person AND is 
entering that information into any computer system, 
the full Internet security requirements must be 
applied to that data.  It is vitally important that 
everyone understand that card data must be fully 
protected, whether in electronic form, on paper, or 
over the Internet. 
 
What should a department do if it is contemplating 
accepting credits cards? 
Each department or business unit must be set up 
within the centralized University banking and 
accounting environment. That is, campus 
departments may not set up their own banking 
relationships for credit card processing and card 
receipts.  The Treasurer’s Office negotiates all 
banking and card processing relationships on behalf 
of the entire University.  Prior approval to accept 
credit cards is required by the Campus Controller 
and the Treasurer’s Office.  For general information 
about starting the process to accept credit cards and 
the related fee structure go to the Treasurer’s 
website at:  http://www.cu.edu/treasury/. 
 
The Treasurer’s Office will work with departments 
and their software providers to discuss credit card 
processing standards, but any labor or expenses 
associated with bringing systems into compliance 
are the responsibility of the unit or department 
owning the system.  Credit card processing systems 
that are non-compliant or cannot be made compliant 
must be removed from service.  For additional 
information, please contact Joe Tinucci in the CU 
System Treasurer’s Office at 303-492-9326 
(Joe.Tinucci@cusys.edu), or UCDHSC Accounting 
Services  Kim.Huber@uchsc.edu, (303-724-0062) 
or Jeanne.Paradeis@cudenver.edu, (303-556-6116).  

 
Time-saving Computer Tips for MS 
Windows:  Keyboard Shortcuts and  
Recording Macros 
Kathy Illian 
Using keyboard shortcuts and macros can minimize 
time spent performing repetitive task.  Here are a 
few popular shortcuts, as well as instructions on 
recording macros in Windows applications like MS 
Word and MS Excel: 

 

Keyboard Shortcuts: 
 
• Ctrl + (select the printer icon in the 

PeopleSoft Financial System): opens a 
PeopleSoft report even if pop-up blockers are 
enabled. 

• Ctrl + (select the pop-up blocker notification 
below your browser address line): allows the 
page to be opened. 

• Ctrl + A: selects all items in current window 
• Ctrl + B: bolds the selected item 
• Ctrl + C: copies the selected item 
• Ctrl + D: opens the “Format Font” menu (MS 

Word); copies the contents from the cell 
above (MS Excel) 

• Ctrl + F: opens the “Find and Replace” 
search feature 

• Ctrl + N: opens a new file in the application 
you’re using 

• Ctrl + P: prints the document 
• Ctrl + S: saves the document 
• Ctrl + U: underlines the selected text 
• Ctrl + V: pastes the contents of the clipboard 
• Ctrl + X: cuts the selected items 
• Ctrl + Z: undoes the last action 
• PrintScreen: copies the entire monitor 

window and places a copy in your clipboard; 
you can then paste it (Ctrl + V) into a 
document as a picture. 

To see more keyboard shortcuts, go to: 
http://support.microsoft.com/ and use the site’s 
search function.  

Keyboard Shortcuts and Macros continued on Page 7 

http://www.cu.edu/treasury/
mailto:Joe.Tinucci@cusys.edu
mailto:Kim.Huber@uchsc.edu
mailto:Jeanne.Paradeis@cudenver.edu
http://support.microsoft.com/
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 Keyboard Shortcuts and Macros 
To add this macro as a command button on your 
toolbar, select Tools→Customize.  On the 
Command menu that appears, scroll down in the 
Categories column to “Macros.”  Notice the 
“Custom Button” that appears in the right column 
under Commands.  Holding your left mouse button 
down, drag the “Custom Button” icon to your 
toolbar, next to another button, or next to “Help.” 
Right-click the smiley face icon, and rename it in 
the Name field that appears in the drop down menu.  
In the same drop down menu, select “Image and 
Text” so that the button name shows. In the same 
drop-down menu, select “Assign Macro,” and 
choose the macro you have just created.  Now all 
you have to do to run the macro is press the 
command button on your toolbar. 

 continued from Page 6 
 
Macros 
Macros are used to automate certain repetitive tasks 
in Windows applications.  Here’s how to record a 
macro in MS Excel that automatically sets your 
page setup to “landscape”, sets the margins to .7 all 
around, and prints the document:  In MS Excel,  
 
Select Tools→Macro→Record New Macro.   
Name the macro, and add a description if you like, 
then press OK.  You’ll notice that a little box with 
recording buttons appears.  
 
Go to File→ Page Setup.  
Select "Landscape”. Change the Top, Bottom, Left, 
and Right margins to .7 and press OK, then press 
the printer icon on your toolbar.  Instructions for a commonly-used payroll 

summary macro and other useful tips can 
be found on Finance’s Training and 
Learning Resources web page at: 
 

http://www.uchsc.edu/finance/Training.htm
 

 
Press the square button in the recording menu to 
stop recording.   
 
Now, anytime you want a document to print with a 
Landscape orientation and .7 margins in that 
application, just run the macro.  To run the macro, 
select Alt + F8, find the macro under the name you 
saved it, and press “Run.” 
  
People News 
 
Teresa Berryman now has oversight over all administrative function of the UCDHSC, picking up the areas that were 
previously under Dana Gibson.  Her title has been changed to Vice Chancellor for Administration and Finance. 
 
Jeff Parker has been promoted to Associate Vice Chancellor for Finance and Administration.  Jeff will retain all the areas 
previously under his responsibility as well as pick up Student Financial Services for both the DDC and HSC campuses. 
 
Bill Herbstreit, Interim Assistant Vice Chancellor for Student Financial Services has announced his departure date and 
will be leaving us effective July, 15, 2005.  Bill came out of retirement and has provide extraordinary leadership during 
the past 5 months.  He’s leaving to resume his retirement and focus more on his family.  Thanks Bill, we couldn’t have 
asked for a better person to help out during this time.  The search for a permanent replacement is still underway.  
 
Ellie Miller, Director of Financial Aid at the DDC since 1980 and of the combined campus since its consolidation, has 
retired effective June 30, 2005.  She will start her new job as Director of Financial Aid at Regis University on July 1, 
2005.  Ellie is leaving after over 33 years of state service, including 4 years at CU-Boulder, a total of 27 years at CU-
Denver and HSC, and 2 years at CCHE.   Thank you Ellie for your many years of service and commitment to CU 
 
Karon Johnson has been appointed Interim Director of Financial Aid while a search is performed.  Karon has many years 
of experience in financial aid and student services at CU-Boulder.  She also has experience working with the non-profit 
sector and in obtaining grant funding for non-profits.  Please welcome Karon when  the opportunity arrives! 

http://www.uchsc.edu/finance/Training.htm

